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Membuat Tulisan

Q, 5
= :
L&) |
B e ' | Kik Mouse kiri Text Tool (F8)
», o] : Lepas dan arahkan pointer ke Drawing Page
G, |
Q| |
@, |
"= J:_L ________ ]
! Klik Mouse kiri, tahan (tekan terus)
: E Geser pointer ke bawah kanan
m X . Lepaskan jika sudah membentuk kotak yang sesuai keinginan
: : anda
| E Setelah dilepas akan muncul gambar spt disamping
E__________________EII>
[ ] im) =

Fetikan tulisan anda disini. ketikan
Iulisan anda disini ketikan twlisan anda
disini.Ketikan tulisan anda disini.
ketikan tulisan anda disini ketikan
tulisan anda disinl. Ketikan twilisan anda
disini. ketikan tulisan anda disini
ketikan tulisan anda disini.

Feetikan tulisan anda disini. ketikan
tulisan anda disini ketikan tlisan anda
disini. Ketikan lwlisag anda disini.
ketikan tulisan anda disini ketikan
tulisan anda disini. Ketikan tulisan anda
disini. ketikan tlisan anda disini
ketlkan tulisan anda disini,

Feetikan tulisan anda disini. ketikan
tulisan anda disini ketikan tulisan anda
disini.Ketikan wlisan anda disini.
ketikan tulisan anda disinl ketikan
Ilulisan anda disini..

Ketikan tulisan yang anda inginkan
Simpan file dengan perintah Ctrl+S atau pilih menu File > Save




Block tulisan, caranya :
Klik Mouse kiri di awal tulisan yang dimulai di block, tahan
Geser kea rah akhir tulisan yang akan di block, Lepas

|§ Mone Chrl4-M
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ZhrH-E
Chrl+R
Chel+1

I = Force Justify  Crrl4H

Atur aligment paragraph sesuai pilihan anda
Kali ini pilih Full Justify (Ctrl+J)
Hasilnya rata kanan-kiri, yg akhir baris rata kiri

fetlkan tulisan anda disinl.  kelikan
fulisan anda disini ketikan tulisan anda
disini, Ketikan tulisan anda disini. ketikan
tulisan anda disinl ketikan tulisan anda
Hisinl ketlkan tulisan anda disin kefikarn:
tulisan anda disinl ketikan tulisan anda
fetikan twlisan anda disini.  kelikan
fulisan anda disinl kelikan [ulisan anfla
disini, Ketikan tlisap anda disini. ketikan!
fulisan anda disini Ketikan tulisan anda
Hisini.ketikan tulisan anda disini. kelikan:
tulisan anda disinl ketikan tulisan andal
glsinl i
petikan twlisan anda disini.  kelikan
tulisan anda disini ketikan tulisan anda!
disini, Ketikan tulisan anda disini. ketikan
tulisan anda disinl ketikan tulisan anda
Hisini.. '
ey

Gambar disamping adalah hasil dari aligment Full Justify




" Ketikan tulisan aﬁda disini. k;etikanil
fulisan anda disini ketikan tulisan anda:
disini. Ketlkan tulisan anda disini. kefikan:
tulisan anda disini ketikan tulisan andar
disini.Ketikan tulisan anda disini. ketikan;
tulisan anda disini ketikan tulisan andai

isini. '

elikan tulisan anda disini. k;etil»:ani
fulisan anda disini ketikan tulisan andai

Block tulisan yang akan diganti jenis font (huruf)-nya
Pilih arahkan pointer untuk memilih jenis font
Klik kiri nama font-nya. Kali ini pilih Monotype Corsiva

m hd =0
Text  Tools  Window  Help
7 L v”@“
A6 Lucida Sans Typewriter »
& Momotype Corriva
AT AMAS
O Arial »
1} Arial Rounded MT Bold
(0 Tt Fo ~
(} Latha AaBbYyZz
fgxt' ngD|S Window — Help
‘ {} Monokype Corsiva v| L5 pt w
6 pk |
o,
Z200%: W 7 ot
T O o
FI ] I 5 pt »
S pk
10 pt
11 pk —
12 pt
14 pt
16 pk

{} Monobype Corsiva w || 17 pt v| |

Block tulisan

Pilih ukuran font (huruf)-nya

Kali ini pilih 18 pt

Jika ukuran dalam pilihan tidak ada (missal 17pt), maka ketikan
saja secara manual di kolom ukuran tulisan tersebut (lihat
gambar bawah)
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Anda juga bisa mengatur lewat Object Porpertis disamping
kanan

Size! o
Piliha gambar £ |
x Atur font dan ukurannya
Format: Alignment-nya, dll
7
Scripk:
|Latin R |
[ | |
B Block tulisan
Pilihlwlarln.a dengan mengklik gambar warna disebelah kanan
] Kali ini pili Cyan

Ketikan tulisan anda iisuu..
ﬁ_r,mﬁ_ma tultsan anda di sind &,mﬁma
tulisan anda disint Ketikan tu,.'.'zsmm
.Jn,i:z disim, Ketikan tulisan Llf;l,.i::q
.ﬂsmz ketikan  tulisan Lm.faq

dimnn Ketrkan tullsan anda 4 S'.Lfm.,
ﬁbm;ﬁ_ml tulisan anda diani &mé_m.
tulisan anda disin,
Ketikan tulisan anda disini. kelil:an:
fulisan anda disini ketikan tulisan anda;
Hisini.Ketikan tulisan anda disini. ketikan;
tulisan anda disini ketikan tulisan andat
;jlslni Ketikan tulisan anda disini. kelikan.
lulisan anda disini ketikan tulisan andal

disini.
Ketikan tulisan anda disini. kelikan:

Gambar disamping adalah hasilnya, warna tulisan yang di blok
menjadi berwarna Cyan




etikan tulisan anda di Sw.',..
ketikan tulisan anda di -S‘E.fl'hl
ctikan tulisan anda

.f 1nt Retikan tulisan anda disini
&bméﬂa tubisan anda dam &,mé}m
tulisan anda disin. KetiRan twlzmu,
;Lmi:z disim, Retikan tulisan ;mi::
s ket Ran tullsan anda disni, i

; elikan tulisan anda disinl. ketilcan.
tulisan anda disini ketikan tulisan-

i anda disini.Ketikan tulisan anda'
Hlslni ketikan tulisan anda disini ketil:an'
[ulisan anda disini.Ketikan tulisan anda.
Hisini. ketikan tulisan anda disini kel:il:an-

kulisan anda disini.
tikan tulisan anda disini. ketilcan.

Block tulisan/paragraph yang huruf pertama akan dibuat huruf
besar

A=
Setelah di blok pilih gambar —'

@@luﬁﬁ

Color: ([ ]

RCIEIE S
width: v

MNone
Colar: [Hairline
0.5 pk

Block Tulisan yang akan dibuat tepi huruf-nya.

Klik gambar| d |( Outline) untuk membuat tepi huruf
Width None ganti sesuai selera, contoh 0.5pt

Edit warna pada kolom Color

Edit Style, jika mau




Memindah dan Mengatur Object
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Ketikan tulisan anda disini. ketikan,
fulisan anda disini ketikan tulisan andas
disini.Ketikan tulisan anda disini. keﬂkani
tulisan anda disinl ketikan tulisan anda;
hlslni.Ketikan tulisan anda disini. ketikam
tulisan anda disini ketikan tulisan anda;
disini. !
Ketikan tulisan anda disini. ketikan|
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Object apapun dalam Window Page bisa dipindah,
baik tulisan maupun gambar

Caranya klik mouse kiri di atas object

Object yang sedang di klik akan muncul kotak-
kotak (™) di pojok-pojok-nya dan tepi tengah.
Gerakan pointer hingga muncul gambar # diatas
object.

Jika sudah muncul gambar # , maka klik mouse kiri
Tahan, gerakan kea rah mana object akan di
pindah

Lepas-kan, maka object akan pindah di area
tersebut

Untuk mengatur ukuran kotak object, arahkan pointer
di kotak-kotak ® pinggir object hingga muncul
gambar *=* (kotak ®™kanan atau kiri). Diatas

tengah dan dibawah tengah akan muncul ‘ .
Jika diarahkan di pojok atas kanan dan pojok kiri

bawah akan muncul gambar "., jika di pojok
kiri atas dan pojok kanan bawah muncul gambar

N

Gambar *™=* maka akan mengarahkan besar/ kecil
kotak/object ke kanan atau kiri.

Gamabar ‘ akan memperbesar/memperkecil
kecil kearah atas atau bawah.

Gambar - atau ~ akan
memperbesar/memperkecil sisi-sisi yang
mengapitnya.

Caranya:
Jika anda telah menemui gambar tersebut, klik mouse
kiri, tahan dan gerakan kearah yang anda inginkan.

Mengatur Kolom Text
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Perhatikan tanda ™ dibawah kotak/huruf. Itu
menandakan bahwa tidak semua text dalam
kotak tersebut di tampilkan.

Klik mouse kiri sekali saja pada tanda ™

Maka akan muncul gambar "
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Letakan tanda disebelah kanan kotak
text yang kelebihan text tersebut.

Klik mouse kiri, tahan

Geser kekanan bawah membentuk kotak
baru pada sisi yang kosong
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Lepaskan klik mouse, maka hasilnya seperti
disamping.

Keuntungan cara ini adalah ketika ada
penambahan atau pengurangan text di kolom
pertama, maka kolom kedua akan
menyesuaikannya.

Begitu juga tatkala kolom kanan diubah
ukurannya, maka text di kolom kedua juga akan
menyesuaikan.




Membuat Kotak dan Background

|Reu:tangle Tool I:FE-]I|

=
=
o

1C 0o

Klik Mouse kiri pada Rectangle Tool (F6)

Klik mouse kiri dan tahan di atas pojok gambar
Gerakan ke pojok kiri bawah
Lepaskan

Jangan panic, tulisannya tidak terhapus tapi berada di
belakang layar gambar kotak

*" Object Properties

S0 m | % m

Fill Type:

Urifarm Fill

niform Fill

Pattern Fill
Postscript Fill
Texture Fill
Mo Fill

Klik pada object properties gambar P . Pilih
Fountain Fill untuk mengatur warna
kotak/background.




Fountain Fill

E]=]a=

||
A

(o ek

Edit From dan To sesuai warna anda. From warna
yang dominan, To warna yang mengiasi warna From.

Founkain Fil

HO0D 0O =
W

Ubah style warna kotak /background sesuai selera.
Ada 4 pilihan. Klik aja gambar yang diinginkan.
Jika kurang puas, klik Advanced, atur sesuai
kesukaan anda

Mengatur Posisi Object/Layer
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) Convert Ta Curves Chrl+Q To:

0 B

E_j Wrap Paragraph Text

L7 Unda Fill Chr4Z

& o Chrly

Capy ChrhC Klik object hingga muncul kotak-kotak ® dipinggirnya
2% Delpte Delete Pilih/klik Order > To Back Of Page (Ctrl+End)

(B Lock Object untuk meletakkan object yang dipilih ke

halaman/layer palng belakang

&l

Shvles dl®) 70 Back OF Page Ctrl+End
Internet Links 4 ©
£) ToBack OF Layer  Shift+PqDn
Cwverprint Fil =
O Conwerk To Curves Chrl+
Make Text Weh Campatible
[ spell check... Chrl+F12
@ Fit Text To Frame
L7 Undo Mowe Chrl+Z . .. .
S cut Chrlax Klik mouse kiri pada Object.
QDF'V CtrI+C K!I!( kanan ] . ) )
%E Delete Delete Pilih Lock Object, agar object terkunci sehingga
ohj mencegah memindahkan atau mengedit object secara
nggak sengaja.
Skvles 3
Inkernet Links 4
Crverprint Eil
& Properties Alt+Enker
ﬁ nlock Object Klik kanan

Pilih Unlock Object untuk membuka kunci, selanjutnya
anda bisa mengeditnya lagi.

Mengatur gambar

& Propettigs Alk+Enker

¥ CorelDRAW X3 - [D:\Documents and S
|”D H=N Edit Wiew  Lawout  Arrange
|H|E (Y mew Chrl+
% Mew From Template. ..
|H (8 [ open... Ctr+O
—— [ Close Untuk memasukan gambar Pilih File > Import
[ T | 3 Close Al Pilih gambar yang diinginkan, klik Import
(‘f;‘ @ Save.., Chrl43
#, &) save ps... Ctrh-Shift+5
@ @ Revert
F |
é Acguire Image 4
ol
%
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Pindahkan Object ke tengah tulisan, caranya
sama saat memindahkan dan mengatur Object
berupa kolom text diatas

Atur ukuran gambar sesuai dengan cara
mengatur besar kecil kolom diatas

T2 Edit Bitmap. ..

Trace Bitmap L4
=$= Conwverk To Curves ChrlHD
E Break Apark ChrlHE
£ Undo Move Ckrl+Z
5 cut Chrh

tulisan ands:
disini. ketikar
tlisan anda disin
ketikan tulisar
anda disini.

Wetikan tulisar
anda disini
katikan tulisar
anda disin
ketikan tulisar

Klik kanan pilih Wrap Paragraph Text
Tujuannya agar text disekitar gambar menjuauhi
gambar.

Setelah mengetahui fungsi Wrap Paragraph
Text, maka pindahkan gambar di atas kiri kolom
tulisan.

Ulangi perintah sebelumnya untuk menghapus
fungsi Wrap Paragraph Text sbb :

Klik kanan pilih Wrap Paragraph Text
Tujuannya agar text disekitar gambar menjuauhi
gambar.
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Iiim Bitrnaps Texk

Adjust
Transform

Correction

Artistic Media

Blend

Zontour Chrl+F2

[
2
4

™ l
Extrude

Add Mew ] [ Add Preset ]

[
|Text b

Keep lines

Reset apply

| adojaau] E:g ‘ zalpadol g pa[qoﬁﬁ

T Envelopg ———————— & = | =
add K Add P £ % e
- o g %]I Pilih Effects - Envelope
~ = ;
) e Klik Add new - Apply
£
— o
=
&
fat
m
a
&
=
T |
b
|Text b
Keep lines
P Reset Apply
L Envelope ———————— &« X | b4

Klik kolom text, maka tulisan Add New akan

muncul. Klik Add New

Letakan pointer di pojok kolom text, tahan

dan geser/tarik.

Gantikan di titik-titik yang lain.

Anda juga bisa mencoba nya untuk gambar.
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Page Curl
g 0

Cirection Paper Color

(&) Yertical (%) Opaque Cul:
Ottt O Transparent Background:

Width %: |1'rrr|'rrrr1'rrrr|'rn'r| Height % ‘Tn'r|'rr|'r}n'rr|'rrrr|

]

l 0K ” Cancel H Hep I

(

Klik gambar

Klik Bitmaps > 3D Effects > Page Curl...
Atur pojok gambar mana yang akan dilipat,
klik pilihanya, Curl ganti dengan warna
dominan gambar

Ganti warna background curl dengan warna
background window page (kotak yg dibuat
utk background diatas). Kliki OK.
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Word Wrap Text

wlisan anda disini.
8 .u: cetikan tulis{

yang sebelumnya dibuat

Buat tulisan, kemudian geser di atas kolom tulisan

* Object Properties ——e— « X | X
P> G 2y o
=
&
Selection; poki-ats Selected
pd
Layer: aVET %
Type: Paragraph %
Texk:Arial &
(Marmal) (EMLY Ut}
Wrap paragraph ot
JE— =
£ MNone b L
kS
Text wrap —
e
Skyle:
Defaulk Paragraph Tex »

AR

Selection: 1 Objects Selected

Layer:
Type:

Laver 1

Paragraph
Texb:dial
(Marmal) (EML

Wrap paragraph
3 Square - Straddle Tex v

Hopsaug 4 | ssipadodd oal o Eﬁ]

- Flows Left

- Flows Right

- Straddle Text
- Flows Left

- Flows Right

- Straddle Text
@ Above/Below

- Sguare

Klik gambar &
Word Paragraph yang semula None edit
menjadi Square — Straddle Text

anda disini. ketik

1 disini. ketik
stulisan an
L disini ketik

tulisan. Ini
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Mengelola Halaman / Window Page

% Fage 1 !Pagez ! n-"‘&:-{.

Gambar disamping menunjukan halaman yang sedang
aktif, yaitu ada dua halaman

kT4l Fename Page...
Insert Page After
Insett Page Before
@ Delete Page

D@ Switch Page Orientation
Page 2 e

Rename Page D_(|

Page name:

| hal 2| |

[ oK l [ Cancel ]

, Pagel % 2:hal 2 f""—‘w

Klik kanan pada nama halaman (Contoh Page 2)
Pilih Rename Page ... untuk merubah nama
Ganti dengan nama baru ( Contoh hal 2)

Insert Page After , untuk menambah setelah halaman
Insert Page Before, untuk menambah sebelum halaman
Delete Page, untuk menghapus halaman

Export File

”D &8N Edit  Miew  Lawout  Arrange
' x:[ (M Hew Chrl-+H
¥ % Mew From Template. ..
H (| (B open... Ctr+o
—— @ Close
|ﬁ| @ Close All
i {ﬁl @ Saven., Chrl45
H, ) save s, Ctrl+Shift+5
@‘ [@ Rewert
Acguire Image
% ﬂ] Impart. .. keI
. Chrl+E
i g‘ Dﬁ Export For Office. ..

Export File untuk menyimpan kedalam format file yang
dikehendaki (jpg, gif, tif, dIl)

Pilih format dan beri nama. Klik Export.
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Export

&.

My Recent
Documents

[

=

()
7]
LN
=
o
]

My Documents

Py Metwork
Flaces

Save in: | | pic sampul laporan ccl23

v| J? ® Ll

X

[C)bahan
[Cec1z3
[Cheds_agus2008
E majalahku.png

File: marne: | rajalahku.png

Save as bype: | PG - Portable Metwork Graphics

[

Export

J |

Cancel

Biografi Penulis

Aris. Penulis tinggal di kota pahlawan Surabaya. Menyelesaikan kuliah tahun 2003 di
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